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1.About

» About Product

Author Netbase Team

Visit us Ajax Drop Down Cart

Changelog Click to view

Video Front-End

Support  @Support Service ; @CMSMart Forum
License GLPv2

Almost well known e-stores today have powerful drop down carts
swiftly revealing the added-to cart products in an excellent dropdown list
appearance. Ajax Dropdown Cart makes ecommerce websites look tidy as well
as competent, giving customer’s pleasures when reviewing products that they
have chosen in shopping activities. Ajax Dropdown Cart Virtuemart extension
is easy for you to set it up like a regular Joomla installation. After you activate
the module and include it in any chosen position in Joomla template (the
top/header is recommended), it is ready to use the dropdown cart.

Virtuemart extension is a great add-on module for your Virtuemart
shop. It supports multi languages and no need to translate anything. Ajax
drop down cart contains whichever currencies that your Virtuemart
website uses. You just translate Virtuemart Component to the native
language, apply the currency, then everything will be automatically set in
terms of Dropdown Cart Virtuemart extension.
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» System Requirements

Sources Available:
v' HTML; .PHP;.XML;.CSS;.JS.

Software Required:
v Adobe Dreamweaver 8+ (or any php-editor);

For uncompressing a template ZIP package:
v" WinZip 9+ (Windows); Stuffit Expander 10+ (Mac)

Virtuemart:

> Supported Operating Systems:
v" Linux x86, x86-64

v" Supported Web Servers:
v’ Apache 2.0.x
v' Xampp 1.8.x

» Supported Browsers:

v’ Microsoft Internet Explorer 9 and above
v' Mozilla Firefox 3.5 and above

v" Apple Safari 5 and above on Mac only

v Opera

v" Google Chrome 7 and above
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» Adobe Flash browser plug-in should be installed
v 5.2.+

v Required extensions:

= PDO_MySQL

Simplexml

= Mcrypt

= Hash

= GD

= DOM

= [conv

* Curl

= SOAP (if Webservices APl is to be used)
v' Safe_mode off

v' Memory_limit no less than 256Mb (preferably 512)

> MySQL:
v EE 1.13.0.0 or later: MySQL 5.0.2 or newer

v EE 1.12.0.2 or earlier: MySQL 4.1.20 or newer

v" CE (all versions): MySQL 4.1.20 or newer

> SSL:
v" If HTTPS is used to work in the admin, SSL certificate should be valid.
Self- signed SSL certificates are not supported.
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2.Installation

» Step 1: Unzip Package

« Unzip B pkg_cms_virtuemart_ajax_cart_UNZIP_FIRST fi]e in your folder.

» Step 2: Upload and Install in Admin Panel

e Go to Control Panel — Extensions — Manage.

B System~ Users~ Menus~ Content~ Components ~ Extensions v Help ~ VirtueMart ~ Quicklook &2 e I
e
ol
& Control Panel ) Joomial
Modules
ONTENT You have post-install  Plugins
There are important post| fequire your attention. To view those messages please select the Review Messages button below
/ New Article Templates
You can review the mesg Language(s) pg the Components, Post e menu item of your site’s Administrator section. This
Q Articles information area won't ap, g all messages.

e Click | ChooseFile | and select file package. Click .

Q.

¥ Joomial

@ Open - . e
@&/' U Local Dk (D) » Download files » v | %9 || Search De fiex P

# Extensions: Install

Exteonions Divectory ™ (JED) now avaitable with Instal from Web onlll o once v Newfolder : v RO

© and all apphc able third party i ense terms { - ° te mod
¢ Favorites i e

Add “Instal froen Wab® tab B ohaja_drop_sown_can
* 4 Ubcones 2

Cutabase + Docurments
& Muic
ad Package Fie nstal foen Folder stall from URL i Pctures
B videos

Upload & Install Joomla Extension S i

& Locat Disk {C)
b P i Local Dk (D)
Extersion pachage file Choose File | 10 Se chosen At amex T

Fle parme Al Frbes =

3 (5= B ) oo
4
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3.Configuration

» Plugin Setting

v’ Step 1: Plug-in Manager

* Login to Control Panel — Extensions — Plugin

o -

- 4 System ~ Users + Menus + Content + Components ~ Extensions + Help ~ VirtueMart ~ Quicklook &2

{> Control Panel Manage ¥ Joomlal’

Modules

You have post-mstalw_

There are important post™ lequire your attention. To view those messages please select the Review Messages button below
Templates

Z New Atticle

s menu item of your site’'s Administrator section. This

pg th mponents, Post-installation mess.

You can rev the mesg

Language(s)

© Articles information area won't ap, all messages

v’ Step 2: Search for Ajax cart plug-in

» Type “ajax cart” in text box and then press Q.

Fiter: Q ) x pe Ascendng
Select Status v s Status  Plugin Name Type = Eleenon 1 Acc )
v - o on M b 10032
Select Type -

Select Access -
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v’ Step 3: Enable/Disable Plug-in, Access Level Setting

* Click on Status’s Drop Down Box to choose either Enabled or
Disabled option for Plug-in.

* Click on Access’s Drop Down Box to choose Access Level for
Plug-in.

& Plugins: Ajax Drop Down Cart for Virtuemart

SRR S PR CCEE
Virtushant Ajax Shoppeng Cant Below Are Other Features of Ajxx Deop Down Cant . This i commurcial module released for Netbase Chd Members  Instantly update Access
Products Into to the cant Immedately update to1al paces of the can, wodking with Pubs
'ubie
Dedenny

P ype
Plugin File
riueenaet_apax_can

> Module setting

v' Step 1: Module Manager

* (o to Extensions -> Modules.

M System<« Users + Menus ~ ntert - mponents ~  Extensions |
{> Control Panel 3
‘
- You have postinstalli P
> Py There are impodant postf wqu Ma
ng th Postunst s Adn
0 a &

v' Step 2: Search for Ajax cart module

» Type “ajax drop down cart” and then press Q.
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m & Eat || Dy Dupicate || v Putlish || © Uspotlish || B4 Chechin || [0 Baxn | I Trasa © Meip || © Optons

Site X v ° Satus  Title Position = Type Pages Access Langusge 1D

© | v | Aax Drop Doan Cant for Virtueman [ wone | Mg Decp Down— Noew ek - «“

- Select Status Caet for Virtoamant

v' Step 3: Module Setting

* Click on Status’s Drop Down Box to choose either Enabled or
Disabled option for Module.

* Click on Position to choose where to display for Module.

Title *

Module Menu Assignment Module Permissions Set Thumbnail for Images Advanced Option Advanced

Show Title
Ajax Drop Down Cart for Virtuemart

Pasition

Module Class Suffix | position-7 X v

Status
Published

Start Publishing

Select Style () Style available @ Custom Color

Text color in cart

=]
Title product color .
Finish Publishing
Title product hover color . -
Border product color . Access
Public &
Text button color .
Crdering
Text button hover color . 1. Main Menu v
Button Color . Language
All v
Upper calor .
Mote
Lower color
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v’ Step 4: Basic options

* C(Click on Style Available Drop Down Box to choose
or change Style.

Title * Ajax Drop Down Cart for Virtuemart

Module Menu Assignment Module Permissions Set Thumbnail for Images Advanced Option Advanced

Show Title
Ajax Drop Down Cart for Virtuemart

o

Pasition
Module Class Suffix position-7 X v
_ Status
Select Style i@ Style available Y70 Custom Color
Style available | Pink v |

Start Publishing

* Click on Custom Color Radio Button to choose or change Color
of all mini cart.

Title * Ajax Drop Down Cart for Virtuemart

Madule Menu Assignment Module Permissions Set Thumbnail for Images Advanced Option Advanced

Show Title
Ajax Drop Down Cart for Virtuemart

o

Position
Module Class Suffix pasition-7 X -
- . Status
Select Style (" Style available(® Custom Color
Published
Text color in cart #FFFFFF Start Publishing
B
Product name color . #146@d1

Finish Publishing
Product name hover color . #e@1blb

B
Border product color Access
Public v
Text button color . #1bagac
Ordering
Text button hover color . #eb38dc 1. Main Menu v
Button Calor . #2643eb Language
All v
Upper color . #281717
MNote
Lower color B #1ffess
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v' Step 5: Set Thumbnail For Images
* Change size for Image Thumbnail

Title *
Module Menu Assignment Module Permissions Set Thumbnail for Images Advanced Option Advanced
Thumbnail Width

Thumbnail Height

v' Step 6: Advanced Option

e Select dropdown type: Select the option when hover or click

e Show icon cart: Choose Hide or Show

e Show delete button/Show input quantity/Show update
total/Show update item/Show empty cart: Choose ON or OFF

e Chooe icon cart type: There are 3 options for you such as Image
list, Font icon or Image upload file

Title *
Module Menu Assignment Module Permissions Set Thumbnail for Images Advanced Option Advanced
Select dropdown type Hover ¥
Show lcon Cart () Hide @ Show
Choose icon cart type () Image list () Fonticon (@ Image upload file
Upload file icon @ Select = XK

Width Height icon upload

Show delete button

Show Input Quantity

Show Update total

Show Update item

Show Empty Cart

ABABAA
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If choose Image list radio: You can choose available image list

Select Dropdown Type Hover L

Show lcon Cart () Hide ® Show

Choose lcon Cart Type @ Image Listy () Fontlcon () Image Upload File
Select An lcon | cartd.png o

If choose Font icon radio: You can change the color and size of icon.

Show lcon Cart ) Hide @ Show

Choose Icon Cart Type () Ilmage List( @ Fontlcon) () Image Upload File
Select Font lcon Type ) = M .|

Select Font lcon Color . #Bcodes

Enter Font Size

If choose Image upload file radio: You can upload any the file as you want

Choose icon cart type () Image list () Fonticon | @ Image upload file
Upload file icon ® | images/stories/ | Select | X

Width Height icon upload
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4.Uninstall

v’ Step 1: Extensions Manager

e (o to Extensions - Manage —» Manage.

B System~ Users~ Menus~ Content~ Components ~ FExiensions ~ Help - VirtueMart~
M Extensions: Manage Manage

+ Enable @ Disable (™ Refresh Cache *K Uninstall m

Plugins
® Templates

L Joomla! wou Language(s) mission to collect some basic statistics.
Update

g In order to better understand our install base and end user environments, this plugin has been created to send those statistics bac

m_ Plugins > System - Joomla! Statistics. Click here to see which information will be sent

s Enable Joomla Statistics?
Database
Wamings Always Once Mever
Install Languages
UEEDEE Q Search Tools « Clear

v' Step 2: Search for Ajax cart Plug-in and Module

* Type “ajax drop down cart” in text box and then press Q.

M Extensions: Manage

+ Enable @ Disable ™ Refresh Cache X Uninstall

@®
Risial Joomla! would like your permission to collect some basic statistics.
Update
L In order to better understand our install base and end user environments, this plugin has been created to send those statistics back
Plugins > System - Joomla! Statistics. Click here to see which information will be sent

LB Enable Joomla Statistics?

Database

Wamnings Always Once Mever

Install Languages

edeciSiss ajax drop down cart Q Search Tools « Clear
[] Status MName = Location Type
O v Ajax Drop Down Cart for Virtuemart Site Module
O v Ajax Drop Down Cart for Virtuemart Site Flugin
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v’ Step 3: Uninstall

* Tick on both two checkboxes of Ajax drop down cart
Plug-in and Module and press % Unnst!

M Extensions: Manage

+ Enable © Disable (™ Refresh Cache (| ¥ Uninstall

@®
TEE Joomla! would like your permission to collect some basic statistics.
Update
L In order to better understand our install base and end user environments, this plugin has been created to send those statistics back to
Plugins > System - Joomla! Statistics. Click here to see which information will be sent
LEEE Enable Joomla Statistics?
Database
Warnings Always Once MNever

Install Languages
Update Sites

ajax drop down cart Q Search Toals = Clear

Status Name ~ Location Type
v Ajax Drop Down Cart for Virtuemart Site Module
v Ajax Drop Down Cart for Virtuemart Site Plugin
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5.Support And Contact Information

» Support

Our Virtuemart team is dedicated to providing customers with the
best Quality, Value and Services. We would love to hear from you. For
feedback about our products, please feel free to contact us at:

@Support Service

Check out our Forum for updates and news.

@CMSMart Forum

> Contact Information

Check out our Facebook page! Regional news and specially selected
products are featured daily.

@CMSMart on Facebook

You can also follow us on Twitter!

@CMSMart on Twitter

If you have any question, don’t hesitate to contact us:

Administration deparment: admin@cmsmart.net

Sales deparment: sales@cmsmart.net
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